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Reports Overview

ServiceCEO contains a large number of reports. These reports are designed to help you
generate useful data to help you make better business decisions.

All of the ServiceCEO reports can be accessed by clicking Reports on the Navigator Bar.
For more, see the Printing/Previewing Reports section.

Tip:
To navigate through the reporting topics in order, please click on the il and
& Ll buttons at the top of the page.

Entering the Crystal License Code into ServiceCEO
To create or customize Crystal Reports® for use within ServiceCEO, you need either:

o Afull version of Crystal Reports 9.0. At the moment, only Crystal Reports
version 9.0 works with ServiceCEO.

e An Integrated Crystal Reports Designer License. For licensing and pricing
details, point your browser to http://www.insightdirect.com/services/custom-
reporting/crystalreports/. You can also purchase one from Online Store in the
Member Center. After purchasing your license, you will receive a license code
from Insight Direct. The license can be purchased directly from the
http://www.insightdirect.com/login.html

Note:

The report designer within ServiceCEQ provides a 14-day trial (from the date of
first use), but after this time you will need to purchase a license to use the
designer.
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Tip:
If you are not comfortable with editing your own reports, we can always create
' your report for you! To learn more, please visit
http://www.insightdirect.com/services/custom-reporting/
€ Custom report quotations can be purchased directly from the Online Store in the
Member Center.

If you have the full version of Crystal Reports, you can create or customized reports right
away. See the Editing Crystal Reports and Adding New Reports sections.

If you have purchased the Integrated Crystal Reports Designer License code, follow these
steps to enter it into ServiceCEO:

1. Login to ServiceCEOQ as an Administrator.
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2. Select Help > Enter Crystal Reports License. The Confirmation dialog box
appears. The License Code dialog box appears.

3. Select Yes when prompted to continue.

4. Type the Integrated Crystal Reports Designer License code into the field. Note
that any code you were provided with the full version of Crystal Reports will not
work here.

5. Click OK.

o

Close ServiceCEO.

~

Login to ServiceCEO as an Administrator. The report designer is now enabled.
Note that only the Administrator can edit Crystal Reports through ServiceCEO.

report in that program and then import your changes into ServiceCEOQ. See the

Tip:
' If you have a full version of Crystal Reports version 9, you can create or edit a
€  Managing the Report List section for details.

Report Categories

Report Types
There are two types of reports in ServiceCEQO:

e Active Reports. Indicated by B, these reports are default ServiceCEO system
reports. These reports cannot be customized.

« Crystal Reports. Indicated by &%, these reports are built using Crystal Reports®.
If you have purchased an Integrated Crystal Reports Designer License, you can
edit the structure and format of these reports.

Customer Reports

ServiceCEQ's Customer reports display information about your customers. These reports
include:

Description
Alert Activity Displays all alerts for a given date range by Crystal
customer and alert type. Report
Birthday and Generates a list of all customers with a birthday | Crystal
Anniversary or service anniversary (based on the Entered Report
Date) within your defined date range.
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Credit Card Generates a listing of all customers whose credit | Crystal

Expiration card expires within your defined date range. Report

Customer Listing | Generates a list of all customers and their Active
essential contact information (name, Report
organization and phone numbers). You can
generate a listing of all corporate customers
and/or individual customers.

Location Access Generates a listing of customers with their Active

Details essential data and the values in their Alarm Report
Code and Access fields as defined in the
Address Information dialog box.

Marketing Generates printed mailing labels, conducts mail | Active

Module merges, and exports contacts to Microsoft® Report
Excel®. See the Demographic Filters section for
an explanation of the filters in this report.

Notes Generates a list of all customer notes in your Crystal
date range. You can also include system notes - Report
notes generated by ServiceCEOQ.

On-Site Generates a list of all equipment warranties Crystal

Equipment expiring within your defined date range. Report

Warranty

Expiration

Service Contract Generates a list of all service contracts expiring Crystal

Expiration within your defined date range. Report

To learn how to print and/or preview these reports, see the Printing/Previewing Reports

section.

Scheduling Reports

The Scheduling Reports display information about your schedules and jobs. These reports

include:

Description

Active Recurring
Schedules

Generates a listing of all schedules with a
status of “Active Recurring” within your
defined date range. You can sort these
schedules by customer name or by the date

Active
Report
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they are scheduled to occur.

Crystal Route Generates a route sheet for every team working | Crystal

Sheet on jobs for every day in your defined date Report
range.

E-mailable Work | Generates a basic work order that is ready to be | Crystal

Order emailed to your customers. Report

Job Cancelations Generates a listing of all job and/or schedule Crystal
cancellations within your defined date range. Report

My Tasks Generates a listing of tasks assigned to the Crystal
current user within the defined date range. Report

New Schedules Generates a listing of all new jobs and Active
schedules created within your defined date Report
range. You can display these schedules by
date, customer, frequency, or campaign.

Project Generates a detailed summary of all projects Active

Management and project visits within your defined date Report
range.

Route Sheet Generates a listing of all jobs for each day in Active
the defined date range. The Classic Style is Report
grouped by date while the CLIP™ style is
grouped by team.

Route Sheet Identical to the standard route sheet report Crystal

including Tasks except that it includes tasks. Report

Schedule Displays all schedules that have been cancelled | Active

Cancelations in the defined date range. Report

Schedule Crystal

Frequency Report Report

Weekly Schedule Generates a detailed summary of the schedule Crystal
for the week. You can organize this report for Report
all teams by date or by team for each week.

Work Order Generates all the information an individual or Crystal
team of employees needs to know for a single Report

job, including any customer or job notes. The
work orders are generated based on the
selected date range with a single work order
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generated for every scheduled job within your
selected date range. The work order report can
be run for just a particular client or a particular
team of employees.

To learn how to print and/or preview these reports, see the Printing/Previewing Reports
section.

Employee Reports

Previous Topic: Scheduling Reports

ServiceCEO Employee Reports display information about your employees. These reports
include:

Description
Birthday and Generates a list of all customers with a Crystal
Anniversary birthday or service anniversary (based on the Report
Hire Date field) within your defined date
range.
Employee Loss Generates a list of all schedules that have been | Crystal

cancelled or rescheduled within your selected Report
date range. Also includes the employee who
serviced the customer before the schedule was
cancelled or rescheduled so that you can
identify problematic schedules along with the
employees who are losing customers.

Employee Payroll | Displays all pay for all employees within the Crystal
Summary date range (based on the date you select when Report
creating a paycheck). If a payroll item has not
yet been included on a paycheck, it will not
appear in this report. Other information that
appears on this report includes:

o Employee Name. All employees with
at least one paycheck in the date range
will appear.

e Pay Types. The amount of payment for
each payment type will appear in its
own column. Payment types are salary,
hourly pay, commissionable pay, flat
fees, tips, and miscellaneous pay.

o Total Pay. The total payment for each
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employee in the date range.

e Grand Totals. The totals for every
payment type, and total pay for all
employees in the date range, appears at
the bottom of the report.

Tip: Once run, you can take the information
from this report and input it into your
accounting package, where you can deduct
taxes, etc. from it and generate the actual
paycheck. You can do this in two ways:

1. Export this gross pay to another format
and import it into your accounting
package. For details, read the Exporting

Report Data section.

2. Manually enter the gross pay for each
employee into your accounting

package.
Job/Task/ Displays all jobs, tasks, and adjustments in the | Crystal
Adjustment selected date range. This report was known as Report
History the Payroll report in versions of ServiceCEO
before 6.0.
Listing Generates a listing of all current employees, Active
including the employee’s name, SSN, title, Report

home phone, work phone and e-mail address.
The Reservice Rate is the amount of times an
employee has worked on a job that has
generated a reservice divided by the number of
jobs the employee has worked on. The three
numbers in the report column show the
percentage for three time periods:

e The last 90 days
e The last year

e All jobs for the employee

Note: A reservice is created by clicking the Re-
do button on the customer's Jobs tab.

The Rank column'’s value is determined by
adding up all the note ranks on the employee’s
Personnel File tab. Each note has a rank
associated with it when it is created, that is
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stored on the employee’s personnel file. The
three numbers in the report column show the
employee’s rank for three time periods:

e The last 90 days
e The last year
e All jobs for the employee

Mailing Label Prints mailing labels for your employees. If Active
you do not filter the report, ServiceCEO will Report

print labels for all employees in the list.

Notes Based on the contents of an employee’s Crystal
Personnel File tab, the Notes report can be run Report
for all employees, a select employee and/or for
a specific note type.

Paycheck Summarizes the employee's paycheck(s) in the | Crystal
defined date range, details the paid jobs and Report

tasks, and its corresponding monetary
information. Designed so you can easily export
this information into a third party accounting
application if necessary.

To learn how to print and/or preview these reports, see the Printing/Previewing Reports
section.

Financial Reports

ServiceCEQ's Financial Reports display information about your company’s payment,
deposit, and revenue details.

Tip:
' The data that appears on ServiceCEQ's financial reports is controlled by the
¢ Posted value. Please see the Posting Invoices section for details.

These reports include:

Description
Accounts Generates a list of each customer’s outstanding | Crystal
Receivable payments broken down to increments of Report

current, 30 days, 60 days and 90 days. Invoices
appear on the report based on the date of the
invoice, even if the invoice's job(s) are not
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completed.
By default, the Detailed A/R report only
displays customers with a non-zero (positive or
negative) balance.
Business Analysis | Summarizes your company’s financial factors. | Active
Report Note that projects are not included in this Report
report.
Campaign ROI Displays the return on your investment from Crystal
your campaigns. Report
Estimated Job Displays a forecast of job costing and Crystal
Cost Detail profitability of scheduled jobs in a defined date | Report
range.
Estimated Job Displays a forecast of job costing and Crystal
Cost Summary profitability of scheduled jobs in a defined date | Report
range.
Credit Card If Credit Card Processing is enabled, displays Crystal
Transaction all processed credit card transactions in the Report
date range you define.
Invoice Generates an invoice for every completed job Crystal
within your defined date range. Report
Job Costing Job Costing at the summary level. Crystal
Report
Job Costing - Line | A detailed Job Costing report. Crystal
Item Level Details | Caution: Due to the amount of data contained Report
in this report, it may take some time to open.
Please be patient.

Job Costing Caution:
Travel time will only appear in the Job Costing report if:

o The employee is paid an hourly rate.

e The Cost travel time to: check box is selected in the Payroll Options
@ dialog box. See the Defining Payroll Options section for details.
In addition, if you have more than one team assigned to different visits of a
project, the project will show as unassigned on the Job Costing report. The Job
Costing - Line Item Level Detail report will show you the specific employee
costing information for the project.
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Job PO Displays every inventory product assigned toa | Crystal
job during the report's date range, along with Report
the job number(s) on which it is being used and
the Purchase Order (PO) line item(s) or
adjustment from which the stock originated.

Past Deposits Displays details associated with payments that | Active
were deposited to an accounting package Report
within the defined date range. If desired, these
details can include any notes that may have
been added from the Deposit Wizard. In
addition, the Past Deposits report can include
all deposits in the selected date range or be
limited to specific deposit 1Ds.

Pending Deposit Displays all completed payments that have not | Active
yet been deposited—i.e., those displayed in the | Report
Deposit tab of the Office Duties section.

Purchase Order Displays all Purchase Orders in the selected Crystal
date range. Only used if you are using the Report
Inventory module.

QuickBooks A detailed transaction report displaying all of Crystal

Exports your exports to QuickBooks for a defined date | Report

Transaction range.

Revenue Displays projected or actual revenue for your Active
defined date range. The report can be Report
customized to include only revenue based on a
particular customer or campaign. This report
will use a job's date of service and not the job's
invoice date.

Service Contract Generates a listing of all service contracts in Crystal
the system for your defined date range. Report

Service Contract Generates a listing of all costs associated with Crystal

Costing service contracts in your defined date range. Report

Statements Generates a summary of invoices created Crystal
during your defined date range. These reports Report

can be used for general information purposes
or as actual bills to be sent to the customer for
remittance. Will only include customers with
outstanding balances.
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Transaction - By Will display all job-related transactions Crystal
Job Date (charges, payments, and adjustments) for Report
completed jobs. Projects will be displayed in
the following manner:
e Fixed project charges will appear on
the project's first visit date, if at least
one visit is completed.
e Variable project charges will appear on
the visit to which they are assigned, if
the visit is completed.
Transaction - By Will display all transactions present on Crystal
Invoice Date invoices on the invoice date. Project charges Report

To learn how to print and/or preview these reports, see the Printing/Previewing Reports

section.

will appear when the invoice is posted (by
default, when the final visit of the project is

completed).

Quotes/Estimates Reports

ServiceCEQ's Quotes/Estimates Reports display specific information about the quotes

and estimates in the system. These reports include:

Description

Estimate Generates a list of all estimates during your Crystal
defined date range. Report
Estimate Displays a listing of all jobs that originated as Active
Tracking an estimate in your defined date range. Report
Quoting Wizard Displays all quotes that were canceled in your Active
Canceled Quotes defined date range and the notes that were Report
entered when you canceled them.
Quoting Wizard Displays all quotes organized by user during Active
Quotes by User your defined date range. Report
Quoting Wizard Displays all quotes that involve schedules for Active
Quotes with your defined date range. Report
Schedules
Quoting Wizard Displays all quotes that do not involve Active

10
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Quotes without schedules for your defined date range. Report
Schedules

To learn how to print and/or preview these reports, see the Printing/Previewing Reports
section.

Products/Services Reports

ServiceCEQ's Products/Services Reports display information about your company’s
products and services. These reports include:

Description

Inventory Levels Displays the current inventory levels for every | Crystal
— By Stock stock location. Also displays the total value of Report
Location inventory per stock location as well as for the
entire company.

Inventory Displays the flow of inventoried parts through Crystal
Transaction ServiceCEOQ, from the time they are received to | Report

the time they are sold\removed.

Inventory Displays the current stock level threshold Crystal
Turnover quantities and comments for every active Report
inventory item. Note that this report will
include all active products, not just those
actively used in inventory tracking.
Master Products Displays a list of either all products, services, Crystal
and Services or all products and services in ServiceCEOQ. Report

To learn how to print and/or preview these reports, see the Printing/Previewing Reports
section.

Printing/Previewing Reports

To print and/or preview a ServiceCEO report:

1. Click Reports from ServiceCEO's Navigator bar. The Available Reports dialog
box appears.

11
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Axtailable Reports

=%+ | Birthday ard Anriver sary Report
5 Credt Card Expiration
(]  customer Listing
B8 | Location dccess Detals
Bl Markating Hodule
E‘- Niotes

[ | On-Site Equipment Warranty Expiration
:-5 Service Contracts Exparation

Description:  Lists all alerts by Custorer and alert bype:

Edt List |

2. Select the appropriate report category. There are six report categories:

1.

a M w Db

6.

Customer Reports

Scheduling Reports

Employee Reports

Financial Reports

Quotes/Estimates Reports

Products/Services Reports

3. Highlight the report you want to run.

4. Click Select. The Print Options dialog box appears.

12
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Print Options for Work Order

Printer
Hame: [HDE‘."DE’I.SJFGLng ML-1450 Series
General |§or-tcr-ts |
-
i ¥ Inchude Company Infa in Hesder
[ Show Add-On Lines
=
-
Wiork Order
-
-
Print R.ange Copies
Start: [ Sj14f004 | End:|Sp4Eom | Hurber of Coples 1
Brint | Presien Cancel

The Print Options dialog box enables you to define the criteria for the report. This criteria
normally includes:

Print Style. Some reports let you choose between different versions of the report
(e.g., Summary and Detailed versions).

Group By. Some reports let you define the grouping order of the report results by
selecting it from the Group By drop-down list. (Note that this option is not
available in the above screenshot.)

Print Range. Many reports require that you select the range of dates for which
you want to display information.

Check Boxes. Some reports let you include or exclude information depending on
what check boxes are selected. In the screenshot above, you have the option to
include your company information on the report header and to display any add-on
lines that may be present.

Copies. If printing the report, select the number of reports you want printed from
the Number of Copies spin box.

Additional report criteria may be available on the Contents tab. Examples of possible
additional criteria includes:

Customers. You can include all customers in the report by keeping the All
Customers check box selected.

To run the report for a specific customer, deselect the All Customers check box
and type search criteria for the customer you want to appear in the field beneath
the All Customers check box. You can search by customer name or by customer
ID. A list of customers corresponding to your search criteria appears in the list
box. Select the customer you want to display from this list.

Options. You can filter the report by the values you select from the drop-down
lists in the Options section. Only values that match the criteria you define here
would appear in the final report.

13
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o Company Structure. If you are running ServiceCEO Enterprise, you can filter
the report by company structure. Depending on your security rights and login
level, you may not see this tab.

Some reports, such as the Revenue and Marketing Module report, have more extensive
report criteria options. For a report of this nature, you would define your report criteria by
selecting a tab or tabs in the first section and defining the appropriate criteria. Next, you
would select the remaining criteria—the sections numbered two and three—before
previewing or printing your report.

For all reports, you can either print your report directly or preview it before you decide to
print the report. To print the report without seeing it first, click Print. The Report will
automatically print on your default system printer.

To preview the report, click Preview. The Report Preview page appears. For more on
Standard reports, see the Standard Report Preview page section. For more on Crystal
Reports reports, see the Crystal Reports Report Preview page section.

14
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T Print Preview

Reports

Spn. Q@EE ~ a1 | e

Birthday and Anniversary Report

Arniversaries socunng bebweasn 152004 and 4182004,

Date

orig. Date

Hame

Address

FOF Expoit  RTF Expost  Excel Expot HTML Expost

Home Work

CUSTOMERS
First Service Anniversary

1242004 12420035
ZAERO04 2 E2003
ZASZ004 292003
M004  3A2003
TR004 ST R003
EMPLOYEES

Lawy Offces of Joa, Bob and Sam

Stevvens, Kenneth

Acime Bulkling Propedies

Spagnoula, Jos

Star Builcing

Employment Anniversary

ZAEZ004  ZAERO0Z
IA12004 310999
12004 3110539
12004 311039
12004 311039
IA12004 310999
Birthday
17 2004 17950
17 2004 17950

Garciapama, Ramon
Bird, Lot ence
Daviz, Chalie
Martinez, Peler
Rogers, Mike

wheabar, Harrielt

Bird,, Lavwrance

Dearviz, Chatlie

1410 Winshincton Stres
Boston, MA 0118

110 Andowver Stree
Andover WM& (M510

32 Portland Sireet
Boston, Ma 02114

50 Friend Strest
Boston, MA 014

190 Conal Strest
Boston, MA 0414

1 anwdory Wy
Boston, Ma 02154

16 Barmers Sirest
Boston, WA M234

17 Caviz Sq
Somervile , MA 02111

27 Kays Wy
Boston, MA 04 34

324 Beacon Street
Boston, MA 0 14

180 Canal 51,
Boston, MA 04 14

16 Barners Street
Boston, MA 01234

17 Daviz Sq
Somervile , MA 02111

(7AT) 3927 B4 1M N (555) F92-78E81 x449

(717) 992.7 B1X X (355) 555-9555 x5

(F17) 9927 S41X K (B17) 434-12089 x

(F17) 992. 751X X

(717) 9927 1K [617) 555-0555 x5

(F17) 9927 S41X K (B17) 232-8473 x

(F17) 992. 751X X

(F17) 9927 EE1XX

(F17) 9927 1K

(717) 9927 S41X X [355) 555-9555

(F17) 992 FEIXX

(F17) 3927 1K X

(F17) 3927 1K X

The Report Preview page enables you to view your report before you print it out. To
navigate between the report records, use these buttons:

PY

Previous record

s

Next record

The Crystal Reports Report Preview page

To preview a Crystal Reports report, click Preview from the Print Options page. The
Report Preview page appears.

15
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% Report Preview

Fle Tools Help
(=5 Cose | 32 Customize | (Z)
* & &k - i 1 of 1+ M o0 B
A
' ) Work Order
Service
Gueat Service, Ine SBT56
180 Canal Street
Boglon, MA 02114
Fhone: @00-471-4200
Wb v T B i R B
Work Location: Bill To:
Home Kannath Stavens
Kenneth Stewens Aftr: Brad Butier
110 Andowdi STiaa! 110 Andovai Stiaat
Andowel, WA 01210 Andower, MA 01810
Fhone Z: (555) 585.5855 »5 Home: (5355) 6558555
Phons 1: (555)555.5855 Woark: (555) S55- 5555 =5
Work Date Arrive Belween D uaration Payment Type Time In
14 Ape-2004 200 00AM - 230 008M 10.00 C b b
Terms Last Sarce Map Code Hey Code Team Time Ol
M at 30 13-Jan-2004 Fags 5 &rid E-5 Kay #3245 MEa Regats
| SemviceProduct D escription Price Oty Rmnuﬂ]
& HWALC Emergency Services Labar Rabe Foi 24 Haur Emergency HVAD Seivicss 125 $0.00
an Sarvice ConliactBillablea Houig - - Labor R ol
Far Z&Hour Emergency HWAC semvices on Service
Coaontract Bilabla H o
& HWALC Maintenanoe Senvices Labor B ates for Regular HVAC Maintenancos 128 F0.00
Serviced - 8- Labot Rates for Regular HVAC
Mlaintanance Sarvices
& HWAL Frogram Maintenance Digcounted Labor B ate For Maintenance Conbract 280 s0.60
Haldars - 8- DEeounted Labeor Rate For
Mainfenanoe Contract Hokers
Subtatal $0.00
T
Total:
o

This page will be different if previewing a Standard report. See Standard Report Preview
page for more.

The Report Preview page enables you to view your report before you print it out. To
navigate between the report records, use these buttons:

4 4 3 M

First record Previous record Next record Last record

To print the report, click = :

Exporting Report Data

While ServiceCEQO’s reports are extremely useful, there may be time where you want to
manipulate the data contained within them. To do this, you can export report data to
different formats.

16
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Exporting Data from a Standard Report
You can export data from one of ServiceCEQ's Standard reports into the following

formats:

o Microsoft® Excel®. Click Excel Export. Saves the report in a Microsoft Excel

format

e PDF. Click PDF Export. Saves the report in .pdf format, so it can be opened with
Adobe Reader.

e« RTF. Click RTF Export. Saves the report in Rich Text Format.

e HTML. Click HTML Export. Saves the report in a .html format so it can be
opened with a browser like Microsoft Internet Explorer®.

Clicking one of these buttons displays a Save As dialog box, where you can navigate to
and select the location on your computer where you want to save the exported
information. Once saved, you can open the file with the appropriate program.

Exporting Data from a Crystal Reports Report

To export data from a Crystal Reports report:

1. Click & The Export Report dialog box appears.

Ecamak

|=8 Acicbat Format (POF) =]

Dastinstion:

|= Disk e

2. Select the format to which you want to export the report from the Format drop-
down list. Your options are:

o

o

o

Acrobat Format (PDF). Will save the report as a .pdf file.
HTML 3.2. Will save the report in a .html file, compliant with HTML 3.2.
HTML 4.0. Will save the report in a .html file, compliant with HTML 4.0.

MS Excel 97-2000. Saves the report in a Microsoft Excel format, with
formatting.

MS Excel 97-2000 (Data only). Saves the report in a Microsoft Excel
format, with no formatting.

MS Word. Saves the report in Microsoft Word® format (.doc).
Rich Text Format. Saves the report in a .rtf format.
Tab-separated text. Saves the report in a .ttx format.

Text. Saves the report in a .txt format.

17
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3. Click OK. A Save As dialog box, where you can navigate to and select the
location on your computer where you want to save the exported information.
Once saved, you can open the file with the appropriate program.

Editing Crystal Reports

To customize a Crystal Report within ServiceCEO, you must first preview it. For details
on previewing a report, see the Running/Previewing Reports section.

If you have a full version of Crystal Reports, you can use it to edit any Crystal Report
outside of ServiceCEO.

Tip:

For a template you can use to create a brand new crystal report, download the

following report file: rptNew.rpt. Add this report to ServiceCEQ, preview it, then
¢ customize it based on the steps below.

From the Report Preview page, click Customize to edit the report. The Design View
page appears:

% Report Preview
Ble Tools Help
B save and Close... | (2 Cose | [B) Preiew | 33 Custarize | )

Main Flaport |
+ @B Database Fields ST B o T I SR 2 I 3 3 0 I o B S 8 1 0 A | R v
+ %4 Formuda Fislds

+ 7] Paramster Eields Fiepen Header [FepaiHesderSection] | R
+ B Group Name Fiskds .
+ B Runring Total Fiekds Fage Header (PapeHeadeiSection] |
# & specal Felds : U Rt BUbToAE
+ : Unibourd Fbkds Group Header #1a: WorkDiders JobT askiD - 0 [GroupHeaderSectionS |
: , A Work Order
s e
: Retumaddress : AlarmCode

Group Header #1b: WorkDiders JobT askiD - O (GroupHeaderSection3 |
= Bcwfnmdres_F aober
Group Header #1c: WorkOrders JobT azklD - O [GroupHeaderSectiond |

Waork Location: ) Bill Yo: :
ﬁwoﬁbcahnn _ :ﬁ@-llTochatmn
Group Header #1d: WorkDiders JobT askiD - 0 [GroupHeaderSection |

= Work D ate Arriye Betwesn @rantouriur Label Payment Type 4 Tirme In
' StanDateTime hrrival Text @ManHourbuValue Mt
: Terms 4 Last Service Map Code Koy Code FCEOTeamVocab | Thme Qut
- Temms LastServioed MapCode KeyCode Teamfiame ]
Group Header #1e: WorkDiders JobT askiD - O [GroupHeaderSection? |
[ SericeProduct TDescription Price aty Amount |
Group Header B2 wWioek Ordes tamsz KiflnstD - 0 [GrovpHeadsSectiont |
. A D s TotExplanation e Hitaty,
Denails [Detai3ectiond |
. BtyhacteDaza TEEsplanation T @Ratedstu] ChE5ub T stalasCu]
Group Fooler B2 WorkDederdberns KitlnstlD - O (GroupF octerSectionl( )
! Growp Footer B1a WorkOrders.J obTazklD - O [GroupFooterSacton] |
; Subtets |;nranu}Ta4a§
. Tax anhxroul_a@
B . Tatal;@GrandTotal
Group Footer B1b: WokDrders.JobT azkiD - O {GioupFooterSaction ) e

18



Reports

Note:

If the Customize button is not active, you do not have a Crystal Reports license.
To edit Crystal Reports reports, users must either purchase a full copy of Crystal
Reports version 9.0 or obtain an Integrated Crystal Reports Designer License
through Insight Direct. Go to http://www.insightdirect.com/services/custom-
reporting/crystalreports/ to learn more about obtaining an Integrated Crystal
Reports Designer License.

11
=

Tip:
' You must be logged into ServiceCEO as an administrator to edit a Crystal report.
o

There are two views on the Report Preview page:

e The Design View. This view enables you to make changes to the report. Click
Customize to display this view.

e The Report Preview View. This view displays how the report will appear when
run. Click Preview to display this view.

When you make changes to the report, it is a good idea to preview them to make sure the
changes work correctly. You can toggle back and forth between the Customize and
Preview views at any time.

Note:
»n_# |f you are customizing a report, we recommend you import it to the database.
IE Doing so means that you can easily share it with other users, and all changes will
—  be backed up when you back up your database. See The RPT File Location
section for details.

Creating a New Crystal Report

The easiest way to create a new Crystal Report is to use a blank report file located on
your computer. In order to keep the blank report file intact, we'll make a copy of the
blank report and use the copy to create the new report.

1. In Windows Explorer, navigate to C:\Program Files\Insight
Direct\ServiceCEO\Reports\ and find the blank report file rptNew.rpt.
If for whatever reason you can't find rptNew.rpt, you can always download it by

clicking here.

2. Create a copy of rptNew.rpt. The easiest way to do this is to copy and paste the
report file into the same C:\Program Files\Insight Direct\ServiceCEO\Reports\
directory.

3. Rename the copy of the rpt file to reflect the name of the report you will be
creating.
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4. Add the renamed report to ServiceCEO.

5. Edit the report to return the information that you want it to contain.

Crystal Reports Fields

Crystal Reports Fields

Use the different branches of the tree on the left side of the designer view to access the
different types of fields in your report. From here, you can editing, renaming, or deleting
formulas, creating new formulas, or inserting formula fields into your report.

o Database Fields. A database is a receptacle designed to store related data. Each
database record is made up of one or more database fields. Each database field
can hold one piece of data (aka value).

e Formula Fields. A formula is an equation designed to produce specific data for
your report. You can use formulas to perform many calculations, including the
calculation of numeric values and the comparison of multiple values.

Tip:
Creating a formula field is similar to creating a formula in Microsoft Excel®.

o =il

e Parameter Fields. A parameter field will prompt the user to enter a value when
used. You can use parameter fields for report titles, record selection, sorting, and
a variety of other uses. Using parameter fields enables you to create a single
report that you can modify quickly to fit a variety of needs.

o Group Name Fields. A group is a set of records that are related to each other in
some way. For example, you might group together all of your customers in the
same Zone. A Group Name field is created when you insert a group into your
report. The Group Name Fields list displays the Group Name fields currently in
your report.

Tip:
Unlike other types of fields, you cannot create a Group Name field through the
Field Explorer. Group Name fields are only created when you insert a group into

your report.

o =uill)

e Running Total Fields. A running total totals all records (in the report, in the
group, and so forth) up to and including the current record. For example, if your
first three records have values of 2, 4, and 6, the running total for each of the three
records would be 2, 6, and 12, respectively. You can use running totals to create
customized summaries and totals. For more, see Running Totals.

o Special Fields. General information, such as Page Numbers, Print Date, and
Report Comments, are located in the Special Fields list.
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Unbound Fields. Fields with no specific format. Note that ServiceCEO does
NOT use unbound fields in any of its default Crystal Reports.

Caution:
Text in Crystal Reports does not support Superscript and Subscript tags.

Adding Fields to a Crystal Report

A database field is a specific field in the ServiceCEO database that can be imported into
your report.

Fields generally come from three types of data sources:

1. Table. The raw data that exists in the ServiceCEO database. Examples include:

o RawCustRecord - all of the fields located in a customer record
RawsServLocRecord - all of the fields located in a Service Location

o RawBillLocRecord - all of the fields stored in a customer's Bill To
location

2. Views. A virtual table that pulls data together from different database tables for

&

ease of use.

Stored Procedures - a pre-compiled collection of SQL statements and optional
control-of-flow statements (i.e., variables, conditional expressions, and variable
arguments) stored under a name and processed as a unit. For example, in the
Work Order report, there are two stored procedures: WorkOrders and

WorkOrderltems. A stored procedure can be used to define a SQL query that you
can use over and over again.

Tip:
If the stored procedure is designed to prompt a user for information on which to

base its query, Crystal Reports will prompt you for that information when you
select the stored procedure for your report.

To display the fields that are already located in the report, expand the current database
fields on the left side of the Design View page under the Database Fields icon.

To add a field to a Crystal Report:

=

M w N

Preview the report you want to edit.
Click Customize. The Design View appears.
Expand the Database Fields icon.

Navigate to the field you want to include. Typically, this involves expanding
either a table, view, or stored procedure.
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5. Click and drag this field to the location where you would like it to appear on the
report.

6. Click Preview. Your changes appear.

7. To add additional fields to the report, repeat steps 2-6. You can toggle between
the Preview and Design views as necessary by clicking the appropriate button.
Note:
reni o Each field that is present in the current report will have a check mark added in
= front of its name in the Field Explorer.
e Duration
=) ManHours
8. Click Save and Close. For more on saving your report, see the Saving Reports
section.
Caution:

If you click Close to close the report without first saving your changes, your
modifications will be lost! Be sure to save your changes before closing this
dialog box. See the Saving Reports section for details.

Formatting Crystal Reports Fields
To adjust the formatting (font, display, style, alignment, etc.) of a Crystal Reports report
field:

1. On the right-side of the Design View page, right-click on the field whose
formatting you want to edit and select Format Field from the pop-up menu. The
Format Editor dialog box appears.
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Format Editar 3
Common |Eu~dﬂ Fort | Paragraph | Hyperink |
Object foimat:
Obgect Mame: | Teamdl ame
CSS Class Name: | ==
I Suppeess gl
Hosizontal Abgrment: Cortered v | gl
W Keep Object Together =
M (Close Border on Page Break gl
[~ Can Grow %I
Tool Tip Test | -
Tewd Bﬁm’[ ||:I r Idﬂg“;
- 2

™ Suppeess If Duplicated [

Dizplay Stiing: gl
Sampis: |

0K | Cancel | bep

2. Select the formatting options you want to use from this dialog box. Your options

include

o

O

o

Common. Basic commands. Common commands include:

Suppress. This will hide the field, but will not remove it from your report.
Horizontal Alignment. Controls the alignment of the text within the field
parameters.

Can Grow. Typically used with Formulas, this command lets the field's
text expand past the field's borders.

Tool Tip Text. The text that will appear when you mouse over the field.

Border. Add a border around your field.

Font. Control the appearance of the field's text.

Paragraph. Define how the paragraph appears.

Hyperlink. Define any hyperlinks you want to be included with this field.

3. Note that you can define a formula for each section by clicking 2 Seethe

Formul

as section for more.

4. When complete, click OK. The Design View page reappears.

More advanced features are accessible by right-clicking on the Database Fields line from
the Main Report tab of the Design View page. These features include changing grouping,
ordering and filtering, or adding new database tables to the report. See the Data Sources
section for details.
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Formatting Numbers in Crystal Reports

To format a number field in Crystal Reports, you access the Format Editor dialog box for
the field as described in the Formatting Crystal Reports Fields topic.

The fourth tab of this dialog box will be a Number tab if you are formatting a number. (If
you were formatting text, this tab would read Paragraph.)

Common | Border | Font  Mumbe | Hyepeetlirik |
Currerscy symbol [systeen dedsult)
¥ Dusphyy Curency Symbol
" Fived
= Floating
H1.123.0000)
Cusshomize. .,
. ' | (§55,555.56) |
0k | Cocel | He |

This dialog box enables you to choose the currency style of your number. Simply select
the style you want from the list.

Advanced Options

1. Click Customize. The Number tab of the Custom Styles dialog box appears.
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Custom Styles |E|
Custenci Symbel  Number |
[ Vs Accounting Fomat
[ Suppeess il Zer E! Decimal Separstos; I_ gl
Diecimals [0 v] 3| ¥ Thousands Sepasioe 2
Roundng [ =]z swbat [ 22
Megastves  [123) ] E! ¥ LeadingZero g'
™ Reverse Sign bor Display E! Show Zeto Values a3
[+ Allow Fiedd Clipping E! [<Defau Forenats |
SR | (455,555.56) |
0k | Cawel | Hep |

This tab provides you further control over how the number appears.

Note that you can define a formula for most sections by clicking #  See the Formulas

section for more.

To change the currency symbol of the number (this includes if you want to change the
number to a percentage), click the Currency Symbol tab.

Customn Styles El
Cunency Symbol |Hu'|'b|!|'|
r
¥ Enable Custency Symbol gl
" Fmd * Floging
[ One Symbol Pas Pags El
Posiion (M - 5
Cuiirery Sisnbeal lx_ gl
Sample: (55,555,56%) l
0k | Cowel |  Hep |

1. To add a symbol to the field, select the Enable Currency Symbol check box.

2. Select the Fixed or Floating option button. For details, see the Fixed vs Floating

topic.
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3. Control the position of the symbol by selecting it from the drop-down list.
4. Type the symbol you want to display in the Currency Symbol field.
5. Click OK.

Grouping Fields

You can create and/or modify the grouping of fields in your Crystal Reports report. To do
S0:

1. From the Design View page, right-click Group Name Fields and select Group
Expert from the pop-up menu. The Group Expert dialog box appears.

This dialog box enables you to group the fields located in the report.

2. To group by a specific field, select the field by which you want to group.
3. Click. The field you selected appears in the Group By list box.

This level of grouping may be sufficient for you. However, if you'd like to further define
the grouping options for a printed report, continue from step four.

4. Select a field in the Group By dialog box.
5. Click Options. The Change Group Options dialog box appears.

6. Select the name of the field by which you'd like to add an additional grouping rule
from the first drop-down list.

7. Select the grouping order from the second drop-down list.
8. Click OK. The Change Group Options dialog box closes.
9. Click OK. The Group Expert dialog box closes.

Advanced Crystal Reports Editing

Formulas Overview

A formula is a symbolic statement of the actions you want to perform on data before it is
displayed on your Crystal Reports report. These are used to provide an extra degree of
control over the report's output. Formula fields are constructed using a simple scripting
language, very similar to Visual Basic. You can use formulas to calculate numeric values,
compare one value to another and select alternative actions based on the comparison, join
multiple values into a single string, and to perform a multitude of other operations.
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Tip:
Formula fields are fields that appear on the report after the @ symbol.
&

A two pass formula is a formula that requires two passes through the data for completion.
The first pass performs some calculation or selection and the second pass performs a
calculation or selection that uses the result generated by the first pass.

An example of a two pass formula is one that calculates the sales for each sales
representative as a percent of total company sales. The first pass sums the sales for each
representative to arrive at total company sales. The second pass divides the sales per
representative by total company sales to calculate the percent of total sales.

Editing Crystal Reports Formulas
To edit a formula field:
1. From the Design View page, right-click the field whose formula you want to edit

and select Edit Formula from the pop-up menu. The Formula Workshop dialog
box appears.

B Formula Workshop - Formula Editor - ArrivalText

Grckese O = o X =2 8 I
mﬁmmmmb;;” Rsove | %2 Sl Y S RIE-TETEY ||9-:|s.1c5_l.lntw jl;x |
=/ 1 Fomuda Fields x| ¥ 2 Repor Fiskds x| = (g Funchions I EE -
X} AddOnlinesTedt 2l & @ InsighiDinect {ODEC (RDO)) A @ Math A e g Anthmetic
X} Anivall et + [ swilueptdata. creptdata [COM Connectiviy] + #Smmaw + [ Comparizons
¥ BilTolocation + [ Financial * g Stings
X3 Explanation + #Slnnus + [gp Ranges
X} GrandToial s (@ Date and Time + [ Bockean
X3 ManHowDuLabel " #Dm Ranges . '*-‘!\ﬂw
X} ManHouDu se + (gl tarays + (g Pattem
X} MyKiDesc + (@ Ranges + (i Coriiol Stachures
X} MiMaseess + [ Type Conversion v + [ Other v
%3 RatedsCur L
%4 SubTotaksCur ' This formula formats the arcival time string.
¥ Test IF IIF(ISHULL ({WorkOrders.hrriveWindow}) ,0,{WorkOrders. ArciveWindow}) = O THEN
X4 TolaLinelbemT ax formula = ToText (TimeValue ({WorkOcders.StactDaceTimel))
X4 Wk Location ELSE
+ [0 Selection Fommilas formula = ToText (TimeValue ({WorkOcders.StaccDaceTimel)) + ™ - ™ + ToText [Time'
+ (] Formatting Formudas END IF
L »

Edit the formula using this dialog box. For more, see the following sections:

Report Syntax
o Creating Crystal Reports Formulas

e Casting Numbers as Currency

2. When you've completed editing the formula, click Save.

3. Click Close to close the Formula Workshop dialog box. The Design View page
reappears.
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Report Syntax

Syntax is a set of rules that you must follow in order to create a correct formula in Crystal
Reports. There are two types of syntax:

e Crystal syntax
o Basic syntax

Almost any formula written with one syntax can be written with the other. Reports can
contain formulas that use Basic syntax as well as formulas that use Crystal syntax. In
general, Basic syntax is similar to Visual Basic, the main difference being that it has
specific extensions that handle reporting needs. You can only use one type of syntax
when creating a formula.

Note:
==/ While you can choose between Basic Syntax or Crystal Syntax, all existing
= ServiceCEO Crystal Reports use Basic Syntax for formula fields. Therefore, be
sure to switch to Basic Syntax when copying one of these formulas.
You must follow the syntax rules to create correct formulas. Some basic rules are:
e Enclose text strings in quotation marks.

» Enclose arguments in parentheses (where applicable).

Caution:
@ Record selection and group selection formulas cannot be written in Basic syntax;
they can only be written in Crystal Syntax.

Creating Crystal Reports Formulas

To create a formula in Crystal Reports:

1. From the Design View page, right-click Formula Fields and select New from the
pop-up menu. The Formula Name dialog box appears.

2. Type a name for the formula in the Name field.

3. Click Use Editor. The Formula Workshop appears with the Formula Editor
active.
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B Formula Workshop - Formula Editor - ArrivalText
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L »

4. Verify that Basic Syntax is selected from the drop-down list.

5. Enter the formula by typing in the components or selecting them from the
component trees.

Tip:
Press CTRL + SPACE to display a list box of available functions. If you've
already typed some text, the list box will display only the functions that are

¢ Possible matches for what you've typed. Double-click the function you want to
add it to the Formula Editor.

6. Click & |f any syntax errors are found in your formula, a Crystal Reports
ActiveX Designer dialog box appears, informing you of the problem.

7. Fix any identified errors.

8. When complete, click Close. A dialog box appears, asking you if you want to
save your changes.

9. Click Yes. Your new formula will appear in the Formula Fields section of the
Design View page.

10. To add the formula to your report, select and drag it to the location where you
want it to appear on your report.

11. Click Save and Close.

Casting Numbers as Currency

If a Crystal Reports formula field results in a number that you want to display as currency
(i.e., $1,235.99), you must cast this number as currency in order to ensure that it is
correctly displayed. This step is essential because Crystal Reports may read a field with a
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monetary amount NOT cast as currency as a simple (non-currency) number, omitting the
partial values (decimal values) from the amount.

To cast a number as currency, use one of the following arguments:
e CCur (number)
e CCur (string)

For example:

' Forces the rate field to a CURRENCY value so
Crystal will apply correct international formatting.
formula = CCUR ({WorkOrderltems.Rate})
Running Totals Overview

In Crystal Reports, a running total totals all records (in the report, in the group, and so
forth) up to and including the current record. For example, if your first three records have
values of 2, 4, and 6, the running total for each of the three records would be 2, 6, and 12,
respectively. You can use running totals to create customized summaries and totals.

Running total fields are similar to summary fields, but provide you more control over
how the total is calculated and when the total is reset. Running total fields are specifically
suited to:

o Display totals as they are accumulated record by record.

o Total a value independent of the report's grouping.

o Total a value based upon conditions you define.

o Total a value after applying a group selection formula.

o Total a value from the driving table in a one-to-many linking relationship.

Creating a Running Total
To create a running total in Crystal Reports:

1. From the Design View page, right-click Running Total Fields and select New
from the pop-up menu. The Create Running Total Field dialog box appears.
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Create Running Total Field
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2. Type a name for the running total field in the Running Total Name field.

3. Select the field you want to total from the Available Tables and Fields list box.

4. Click # . The field will appear in the Field to summarize field.

5. Select the type of running total you want to produce from the Type of summary
drop-down list. Your options will vary depending on the field you chose to
summarize.

6. In the Evaluate section of the dialog box, click the appropriate option button.
Your options are:

For each record. The running total will run for every record.
On change of field. The running total will only run when a specified field
has changed. Use the * button to copy a field from the Available Tables
and Fields list to the On change of field list.

o On change of group. The running total will only run when a specified
group has changed.

o Use a formula. The running total will use the identified formula when

performing its calculations. Click 2 10 create identify a formula.
7. In the Reset section of the dialog box, click the appropriate option button.

o Never. This means that the running total will never reset; that is, the
running total continues throughout the report. your running total will
perform its calculations on that field throughout the entire report.

o On change of field. Use the On change of field list to have your running

total evaluate or reset when a designated field changes. Use the *
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=

button to copy a field from the Available Tables and Fields list to the On
change of field list.

o On changing of group. The running total will run or reset when a
designated group changes.

o Use aformula. The running total will use a formula to determine when to

reset. Click 22 to create identify a formula.
Click OK to save the running total field. The program returns you to the Field
Explorer dialog box.

Insert the running total field in the Details section of the report.

Note:

A running total field can be used on database fields and first-pass formulas, but
cannot be used on second-pass formulas or formulas that reference other second-
pass formulas.

The following list identifies the records that are included in the calculation when a
running total is placed in the specified report sections. This list assumes the running total
IS not reset.

Report Header - only the first record in the report
Page Header - all records up to and including the first record on the current page

Group Header - all records up to and including the first record in the current
group
Details - all records up to and including the current record

Group Footer - all records up to and including the last record in the current
group
Page Footer - all records up to and including the last record on the current page

Report Footer - all records in the report

Data Sources Overview

Data for ServiceCEO reports can come from three sources:

Tables.
Views.

Stored Procedures. Stored procedures are pre-compiled collection of SQL
statements and optional control-of-flow statements stored under a name and
processed as a unit. For more, see the Crystal Reports Fields section.

Adding Tables
To add a table to a Crystal Report:
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1. From the Design View page, right-click Database Fields and select Database
Expert from the pop-up menu. The Database Expert dialog box appears.
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2. Expand the Available Data Sources folder structure as displayed in the screenshot
above by clicking the appropriate plus signs. All of ServiceCEQ's tables are
located in the Tables folder.

To add a table to the report, simply select the table you want to add and click * . The
table will appear in the Selected Tables list box.

To remove a table from the report, select the table you want to remove in the Selected
Tables list box and click ¢

Stored Procedures

In retrieving data for Crystal Reports reports, the Stored Procedure is called, is wrapped
through COM (such a process was required due to a ‘known’ issue for Crystal Reports ),
and then the stored procedure accesses the ServiceCEO database to obtain the data. An
example of Stored Procedure can be seen in the Work Order report.

Subreports

A Crystal Reports subreport is a report within a report. It has all of the characteristics of a
regular report, but cannot include other subreports within itself. Subreports can be free-
standing or they can be linked to the data in the primary report. You to insert as many
subreports as you want into a regular report.

There are four instances in which a subreport would typically be used:
e To combine unrelated reports into a single report.
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e To coordinate data that cannot otherwise be linked.
e To present different views of the same data within a single report.

o To perform one-to-many lookups from a field that is not indexed on the lookup
field.

For example, the picture below shows a report that contains the “RSEmployees”
subreport, designed to display the employees for each job type. If no team is assigned to
the job, it will be displayed as “unassigned” (Team Name).

To add a subreport to a Crystal Report:

1. Inthe Customize view, right-click on any empty space in the report and select
Insert > Subreport from the pop-up menu. A frame box appears.

2. Mouse to where you would like the subreport to appear and click the mouse to
place it on the report. The Insert subreport dialog box appears.

3. If you want to use an existing subreport:

1. Select the Choose a report option button.

2. Click Browse. An Open dialog box appears.

3. Browse to and select the subreport you want to use and click OK.
4. If you want to create a new subreport:

1. Select the Create a subreport option button.

2. Type a name for the subreport in the Report Name field.

3. Click Report Wizard and follow the steps to create the subreport.

5. If you would like the subreport to only be run when asked for, select the On-
demand Subreport check box.

6. Click OK.
Parameters

Parameter Fields

Parameters prompt the user of a report to enter information. Think of a parameter as a
question that the user needs to answer before the report is generated. The information that
you enter, or the way in which you respond, determines the information that appears in
the report.

For example, in the Work Order report, the date range is defined by two parameters:
o Start Date (CEOStartDate)
e End Date (CEOENndDate)
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The report then uses the values the user selects (in ServiceCEQ's Print Options dialog
box) to define a Time Frame'. The results returned by the report will fall within this
‘Time Frame’ rather then returning the results for all time periods.

The Parameter Fields list on the Main Report tab of the Design View page displays the
names of all the Parameter Fields currently in your report. You insert Parameter Fields by
dragging them into the report, or by selecting them and then clicking Insert to Report.

You can create a New parameter field, or edit, rename and/or delete the parameter field
by right-clicking Parameter Fields and select the appropriate value from the pop-up
menu.

Defining the Default Value of a Parameter

All Parameter Fields must have a defined default value in order to avoid being prompted
for parameters at runtime. To define a default value:

1. From the Design View page, right-click on the parameter to which you want to
define a default value and select Edit from the pop-up menu. The Edit Parameter
Field dialog box appears.

Edit Parameter Field

O ptaons

(% Disciste vahue(s)

™~ Range vahmls] I+
~

oK Concel | Hep

The other parameter options include:

o Allow multiple values. Select this check box to identify more than one default
value for the parameter field.

o Discrete value(s). Select this option button to select only single values for the
parameter field. If you have selected the Allow multiple values check box, you
will be able to select more than one discrete value for your parameter field,
though those discrete values will continue to function as single values as opposed
to a range value.

e Range value(s). Select this option button to select a range of values for the
parameter field.

o Discrete and Range Values. Select this check box (if you have selected the
Allow multiple values check box) to enable the selection of both discrete and
range values for the parameter field.
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Caution:
@ You can only select Discrete value(s) OR Range value(s). Both cannot be used at
the same time.

2. Click Set Default Values. The Set Default VValues dialog box appears.

set Default Values

Salect from database
Brovese lable: [ -]
Erovese held: | j
Selech o entes vahue o add
Deefoult Vakues Desciiplion +]4]
| -y |
L
4
Inpotpick kst | Expotpickist | Define descriptin
Oipdions
" Rapge Limsted Field Drizpleyr |\"db.|e and desciphon j
i Ve |I:I fuii] [ Dirder: |N-r.| Sort j
Mag Vale [o.00 | ~]
Ok, | Cancal Heo |

e To add a default value: Type a value in the Select or enter value to add: field

and click * to add the value to the Default Values list box.
o Toremove a default value: To remove the existing default value, select the value

in the Default Values list box and click ~ *

3. After you've finished configuring the default values, click OK. The Set Default
Value dialog box closes.

4. Click OK. The Edit Parameter File dialog box closes.

Supported Parameters

ServiceCEO supports the following parameters. Note that they are presented in no
particular order.

e CEOTeamVocab
o CEOStartDate

e CEOEndDate

e CEOTeamID

e CEOEmployeelD
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e CEOLoginID

e CEOJobID

o CEOInvoicelD

e CEOCustomerID

e CEOShowAddOn

e CEOServConStatusiD
e CEOQOServConSubStatusiD
e CEOShowCompanyinfo
e CEOJobStatusID

e CEOJobSubStatusiD

« CEOOrgID

« CEOBatchJobID

o CEOInvStatusiD

e CEOInvCustOnly

e CEOOrgStructiD

o CEOOrgStructLevel

e CEOOnlyUnsent

e CEOEstStatusiD

e CEOEstSubStatusID

o CEOTaskStatusID

e CEOTaskSubStatusID

Passing Parameters to Subreports by Name

Parameters that begin with "CEO" - such as CEOStartDate and CEOEndDate in the
Work Orders table - are scanned by ServiceCEO and used to adjust the Print Options
dialog box to provide user interaction.

If you have the same parameters in the subreport as those in the Parent report, name the
subreport's parameters the same as those in the Parent Report. Matching parameter
names will ensure you will not be prompted for parameters at runtime. For example, the
CEOCustomerID parameter is present in the Work Order report. To pass that
parameter within the subreport, rename the existing CustomerID parameter in the
subreport to CEOCustomerID. To do this, right-click it and select Rename from the
pop-up menu.
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Defining a Default Date Range

Users with Crystal Reports version 9 or the Integrated Crystal Reports License can now
edit the default Start and End dates for any of ServiceCEO's Crystal Reports. You can
define the date range for a Crystal Report in two different ways:

1. Use a Default Date Range

2. Encode a Default Start/End/Single Date using Offset Notation

Use a Default Date Range

To use a default date range, you need to create a parameter named CEODefDateRange,
with a data type of Number. You can set the default value of this parameter in the Public
Enum eDateFiltRange table:

To set the default values, you'll need to use the following terms:

eDFR_AII 0 All dates.

eDFR_Today 1 The current date.

eDFR_Today Morning 2 The morning of the current date.
eDFR_Today_Afternoon 3 The evening of the current date.
eDFR_Yesterday 4 The day before the current date.
eDFR_Tomorrow 12 The date after the current date.
eDFR_ThisFullWeek 5 The entire week containing the current date.

The entire week starting the week BEFORE

eDFR_LastFullWeek 6 the current date.

The entire week starting the week AFTER the

eDFR_NextFullweek 8 ==

FERI
— Note:
IE A full week starts on the Monday previous to the current date.
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eDFR_ThisFullMonth 9 The entire month containing the current date.

eDER LastEullMonth 10 The entire m_or_1th occurring the month before the
- month containing the current date.

The entire month occurring the month AFTER

eDFR_NextFullMonth 11 the month containing the current date.

eeen o NoOte:
E The full month starts on the first and ends on the last day of the month
(the 30th or the 31st).

The week (seven days) previous to and including the
eDFR_LastWeek 13 current date. For example, if today was 8/25, the last
week would be 8/18 though 8/25.

The week (seven days) after and including the current
eDFR_NextWeek 14 date. For example, if today is 8/25, the next week is
8/25 through 9/1.

eem 2 Note:
E The LastWeek and NextWeek strings contain seven days from (and
including) the current date, so they don't necessarily start on Monday.

The month previous to and including the current date.
eDFR_LastMonth 15 For example, if today is 8/25, the last month is 7/26
through 8/25.

The month after and including the current date. For
eDFR_NextMonth 16 example, if today is 8/25, the last month is 8/25
through 9/24.
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Note:

=~/ The LastMonth and NextMonth strings contain 30 days from (and

= including) the current date, so they don't necessarily start on the 1st or
31st of a month.

Encode a Default Start/End/Single Date Using Offset Notation

To use offset notation, you will need to create either a pair of parameters
(CEODefStartDate and CEODefEndDate) or, for reports driven from only one date, a
single parameter (CEODefSingleDate). The data type of these parameters will be a
String.

Set the default value of each of these parameters to a string in the format: [+/-
1[#][m/dlyyyyl/...]. For example, defining CEODefStartDate = -5d and
CEODefEndDate = +12ww will generate a report with a start date of five days ago and
an end date of twelve weeks from the current date.

The table below contains the set of strings which can be included as part of the above
parameter string.

Setting | Description
yYyYyy Year
q Quarter
m Month
y Day of year
d Day
w \Weekday
WW \Week of year
h Hour
m Minute
S Second
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Saving Crystal Reports in ServiceCEO

When you are done editing a report, save your changes. All Crystal Reports are saved as
a Report Definition File.

Note that if you are storing the ServiceCEQ reports in

Tip:

Before you save your report, it's always a good idea to run Verify Database. To

do so, right-click on any white space of the report in the Customize tab and select
¢ Verify > Verify Database from the pop-up menu. Doing so will ensure that all

of the report fields will work properly.

Caution:
Installing a ServiceCEO upgrade will update all of ServiceCEQ's default reports
(located at C:\Program Files\ServiceCEO\Reports), overwriting all previous
versions. If you have edited any ServiceCEO reports and have NOT saved them
under a different file name (i.e., you have overwritten the default report files with
@ your own custom versions), be sure to save a copy of these files elsewhere on
your computer/network BEFORE proceeding with the upgrade. Rename the
copies of these report files using unique file names (the
rptWorkOrderAcmeCo.rpt, for example).
After the upgrade is complete, you may copy these renamed report files back to
the original ServiceCEO Reports folder or simply leave them in the separate
location in which they were copied. See Managing the Report List for more.

To save a Crystal Report:

1. On the Report Preview page, click Save and Close to save your changes. A Save

Changes? dialog box appears.

Save Changes?

?.IJ ‘weinld yiou ke bo save changes made to the design of this report?

e
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Caution:

This dialog box is asking if you want to overwrite the existing report definition
file. You should only click Yes if you are making further changes to a report you
have previously modified and saved under a different name. Do NOT overwrite
any of the core system reports (listed below).

Click No to save the report yourself. You will click No most of the time,
especially if you are editing one of the core system reports, such as:

o Work Orders - rptWorkOrder.rpt
o Invoices - rptinvoice.rpt, rptClassiclnvoice.rpt
Estimates - rptEstimate.rpt, rptClassicEstimate.rpt

Clicking Yes will overwrite the existing .rpt file, making your new report the
default report within ServiceCEO. If you do this, be aware that upgrading the
software will overwrite your .rpt file and you will lose and customizations you
may have made. If you click Yes, the report is saved and you can skip the rest of
the steps.

Note:

We recommend that if you make changes to any of the reports that are shipped
with ServiceCEOQ, you save these changes under a different file name. Changing
the name of the RPT file ensures that the file will not be overwritten if you
update your ServiceCEO software. In fact, it is a good idea to save a backup
copy of edited reports on a different location on your network just in case the
edited report is accidentally overwritten.

A Save As dialog box appears.

42



Saveir: | Repods

B rptan. mpt
_‘b 5 rptclassicE stimabe.rpt
MyRecent [ mptclassicinvoice.mt
Documenls ) ot CustCCEpire.mpt
w BB rpteust pspEscpine. it
2] rptCusthiotesDate.rpt
Deztkiop = ot Estimabe oot
[ rptirmt oc Tak als.rpt
__J B eptirecice. it
[ rptirvecice_TatalsCnbe. rpt
2 rptirwoice-ServCon.pt
. [ rptlrecice-Servion_TotalsOnky.rpt
pjj E‘I rptIrn Turrider . rpt

My Computer |

My Documents

- o« & ek -

[E] rptMatenisiscose rpt

[ rpbty T asks ot

E rptProdseny . pk

[ rptroutesheet.mt

E rptSandCan. rpt

[ rptservCorCosting.rpt

E rptSenvConE xpire.rpt

(5 rptstatement2. rpt

[ rptsubwestly Jobschedules rpt
[ rptwreskly oS hedule. it

[ rptworkrder ot

[ rptwiorkrderEmasil.rpt

[E] rptwrarkCrder-E quinment -2 rpt

w File pmme [ pled ik Olrder.apt j

. i

MyMatwaik,  Saveastpe  [Fepor Definitions [1p!) ]
Places

Reports

[ rpewor
B rpewwror

Save

Cancel

4. Save your report using a different file name and/or in a different location on your
computer. Note that, by default, report definitions are stored in the C:\Program
Files\ServiceCEO\Reports directory.

5. Click Save. The report is saved.

Caution:

It is a good idea to backup your customized reports. While reports that are

database backup procedure, customized reports are not. Thus, it is a good idea to

: embedded in ServiceCEO are automatically backed up as part of the normal

have a copy of these reports in a safe place (and outside of the C://Program
Files/ServiceCEOQ directory) to ensure that you will have a copy of the report if
something happens to the original.

Please note that if you have saved the rpt file to the ServiceCEO database (as described in
the RPT File Location section), you will not be prompted to save your changes to a
different location if you use the above steps. Instead, you should save the report in this

manner:

1. Right-click the white space on the left-side of the Customize Report section
(below or next to where the tree of all the report/database elements are) and select
Report > Save to Crystal Reports from the pop-up menu.

The Report List

Managing the Report List

The Report List defines where your reports are located and how they can be accessed.
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To access the Reports List, log in to ServiceCEO as an Administrator, and then follow

these steps:

1. Select Reports from the Navigator bar. The Available Reports dialog box

appears.

2. Click Edit List. The Reports List dialog box appears.

% Report List H=1lE3
Instructions:
The: following repoits ane avalable. For infomation on adding rewv
~ repoats bo Hhe sesbem, consull pow documentation o
Report Catagory o
Service Contrack Financial Halp
Service Contract Costing Financial
Bccounts Receivable Financial
Campakgn ROT Financial
Cradt Card Transaction Financial Add
Estimated lab Cosk Cieksd R asoed | Financisl
Estimated Job Cost Summary Rer Financial b Q
Fropertias
Dsscriphion:

active Jobs, This will allow users the abiity to know before scheduling a
o if it will be a profitable endesvor once ol product cost and Employes: and

hizz report will give users the capabiity bo forecack the Job Cost and Profit
of
rep payrol Sre déducted.,

% Access the Report Defiration from the Following file:
[FptEstimatedichCost_Detai.rpt =

Mote: Thes File must be accessble bo all users on a network
through this Fle name.

" Save tha Repart Definktion in the ServiceCED databass:
Naobe: This will sightly noreass the size of databess badups, and
may decraase reporting performance o remobs confections

W Show on Job Window
¥ Show on Estimate Window

[ Ehiow on Project Window|

Report List

From the Report List dialog box, you can do several things:

Add new reports to ServiceCEOQO. See the Adding New Reports section.

Edit the configuration of existing ServiceCEOQ reports (including the category,
description, and location of the report). See the Editing Report
Descriptions/Sections section.

Remove custom reports from ServiceCEQ. See the Removing Reports section.

Add reports to the Job, Estimate, and/or Project record. If added to a window,

you'll be able to run it by clicking the Report Preview button from the appropriate
record.

Adding New Reports to ServiceCEO
To add a report to ServiceCEO:
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From the Report List dialog box, click Add. A new row appears in the report list.

Type a name for the new report in the Report field.

Select a section for the new report from the Section drop-down list. The report
section is the Report Category under which it appears on ServiceCEO's main
Available Reports page.

Type a description for the report in the Description field.

Indicate the Report Definition File location. See the RPT File Location section for
details.

Repeat steps 3-7 to add additional reports.
Click OK.
Tip:

For a template you can use to create a brand new crystal report, download the
following report file: rptNew.rpt.

Adding Reports to Jobs, Estimates and Projects

You can add reports to jobs, estimates and projects so that they can be run outside of the
Reporting section.

Caution:
Any reports you display on the job record will need to have CEOJobID as the
only required parameter.

Any reports you display on the Project Control Panel will need to have
CEOBatchJobID as the only required parameter.

If the reports are constructed in any other way, it will not run correctly. For more
on editing reports in ServiceCEOQ, please see the Editing Crystal Reports section.

To add a report to the job record report list:

o w0 poE

Click Reports from the Navigator bar. The Available Reports dialog box appears.
Click Edit List. The Report List dialog box appears.

Select the report you would like to add to the report list from the list of reports.
Select the Show on Job Window check box.

Click OK.

To add the report to the estimate or project, select the appropriate check boxes.
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Reports will display according to these rules:
e Selecting Show on Job Window will display the report for jobs and project visits.
o Selecting Show on Estimate Window will display the report for estimates.

e Selecting Show on Project Window will display the report for the Project
Control Panel, not for individual project visits.

e Schedules (Master Jobs) will not display any of the reports.
Once added, you can run the report from two locations from the job, estimate, or project:

e Print. Click the arrow next to the print icon or select File > Print > [Report
Name].

o Print Preview. Click the arrow next to the Print Preview icon or select File >
Print Preview > [Report Name].

Editing Report Description and/or Section
To edit the description and/or section of a ServiceCEO report:
1. From the Report List dialog box, find the report you want to edit and select it.

2. To change the report section, select a new section from the Section drop-down
list. To open the drop-down list, click in the Section column for the report you
want to edit. The report section is the report Category under which it appears on
ServiceCEQ's main Available Reports page.

3. Edit the report description by editing the text in the Description dialog box.
4. Repeat steps 1-3 to edit additional reports.
5. Click OK.

The RPT File Location

By default, all reports are saved in each client computer's local hard drive. By default,
this location is C:\Program Files\Service CEO\Reports.

You can easily change the location of the RPT file from the Report List dialog box:
1. Select the Access the Report Definition from the following file: option button.

2. Click .. The Select Report File dialog box appears.

3. Navigate to the location where the report file (with an ".RPT" extension) is
located and select it.

4. Click Open. The name of the report definition file appears in the field.
5. Click OK.
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This configuration is the most efficient method of managing your report files, and is
recommended for:

o All standard reports shipped with ServiceCEO
e Single-computer installations
» Reports that will not change

This configuration requires that you distribute copies of these reports to all users running
ServiceCEO (i.e., each user's Reports folder must be identical). You must also be
responsible for backing up changes to these reports and ensuring that they are not
overwritten when upgrading ServiceCEO (see the warning in the Saving Crystal Reports
in ServiceCEOQ section).

If you have multiple users connecting to a single ServiceCEQ database, you can utilize
two other methods of managing your report files:

o Save the RPT files in your database. Saving your reports in the ServiceCEO
database means that reports will be automatically downloaded to your computer
whenever you print or preview a report that you have not used before or one that
has changed. This is recommended for customized reports in an installation where
users will be accessing the reports over remote connections. To do this:

1. Open the Report List dialog box.

2. Select the Save the Report Definition in the ServiceCEO database
option button.

3. Click Import Report. The report is now located in the database.

o Save the RPT files on a network drive. Saving reports on a network drive is
recommended for customized reports where users will be accessing reports over a
high-speed LAN. The fileserver containing the reports should be backed up on a
regular basis. This configuration is not as efficient as saving the .rpt files in the
database.

Caution:
It is a good idea to backup your customized reports. While reports that are
embedded in ServiceCEOQ are automatically backed up as part of the normal
@ database backup procedure, reports not embedded in the database are never
backed up or saved. For this reason, it is a good idea to have a copy of these
reports in a safe place (and outside of the C://Program Files/ServiceCEO
directory) to ensure that you will have a copy of the report if something happens
to the original.

If you wish to centrally locate your report definitions for easier management, you have
two options:
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1. Place your RPT files on a network drive. Edit the report definition file location
to point to this new shared drive by clicking the button from the Report List
dialog box. Navigate to the network location where the report files are located.

2. Load the report definition files directly into the ServiceCEO database. This
will allow report access from any system which has access to ServiceCEO,
regardless of whether ServiceCEO is on a network or not.

Removing Crystal Reports from ServiceCEO
To remove a Crystal Reports report from ServiceCEO:

1. Select Reports from the Navigator Bar. The Available Reports dialog box
appears.

Click Edit List. The Report List dialog box appears.
Find the report you want to delete and select it.

Click Delete. A confirmation dialog box appears.

o~ w

Click OK. The report will be deleted from ServiceCEO.

Note:
You will not be able to delete the default ServiceCEO system reports (i.e., the
reports detailed in the Report Types section).

11
[

Caution:
@ Deleting a custom report only removes the report from ServiceCEO. It does not
erase the RPT file from the C:\Program Files\ServiceCEO\Reports directory.

Additional Information

For more on modifying Crystal Reports, you can attend our live Crystal Reports class.
For more information, please point your browser to
http://www.insightdirect.com/classes.html.

In addition, we strongly recommend you purchase and use some of the third-party
resources listed below:

e Crystal Reports 9 for Dummies (Paperback)
ISBN: 0764516418
Purchase from: http://www.amazon.com/gp/product/0764516418/103-4708519-
4012629?%5Fencoding=UTF8&v=glance&n=283155

e Mastering Crystal Reports 9 (Paperback)
ISBN: 0782141730
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Purchase from: http://www.amazon.com/qgp/product/0782141730/103-4708519-
4012629?%5Fencoding=UTF8&v=glance&n=283155

Crystal Reports 9: The Complete Reference (Paperback)

ISBN: 007222519X

Purchase from: http://www.amazon.com/gp/product/007222519X/103-4708519-
4012629?%5Fencoding=UTF8&v=glance&n=283155

Computer Based Training CD ROM (CBT): Crystal Reports 9 Report
Design Users from Business Objects (Computer-Based Training)

Item #: CG7UTD

Purchase from:
http://www.buy.com/retail/product.asp?sku=10354144&loc=101&sp=1
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